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Editor 
 
I must admit I never know what to write in this 
section. If you are like me you probably haven’t even 
read any editor comments from any magazine, 
instead wanting to rush in and look at the contents 
page. 
 
So here is some more text then no one will read, 
seriously we have some more reviews and 
interviews. The amazing commodore DTV hack from 
Jason Winters, who seems to be a reader of the 
magazine, great you must read this item if nothing 
else, it goes to show the skill from some of these 
hardware hackers. 
 
Jasons machine says buy me and if you are in a 
position to mass produce such an item then do so, I 
would imagine quite a large market on such a device. 
I have been proved wrong before on many 
occasions. 
 
Again I plee for anyone reading to write a page or 
two about a Commodore related item, maybe its 
about why you love Commodore or why you think it al 
went wrong for the company.  
 
Could it be that you left the “commodore Scene” and 
returned later to find an explosion of products and 
software had been released, with more hardware on 
offer now than ever before, Commodore dead, you 
must be joking mate its more alive than you think.  
 
Maybe you just have a link to a website with some 
Commodore related item fine sent that, and I will 
write something for you, Are you a hardware or 
software designer wishing to promote you wares, fine 
let me know, as ever “Do something rather than 
nothing” 
 
 
Best regards 
Commodore Free 
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Readers Comments 
 

Jason Winters 
Hello, 
Great magazine!  I just stumble upon your site today, 
I'm definitely bookmarking this page 
Commodore Free 
More nice comments I like to receive positive 
feedback, in fact any feedback is good. 
 
Boris Kretzinger 
Hi Nigel, just recently found your mag on the web, 
very nice one with good articles I have to admit. 
We do a monthly c64-pdf-mag in German language 
since 05/2005, which is quite hard because our staff 
is not that big ... well, guess you know the problem, 
too :) So I'd like to suggest a cooperation: We do 
Interviews with several guys on current projects or 
news around the commie on a pretty regular basis. 
Since most sceners live outside Germany, I have to 
interview them in English, anyway, and could send 
you this interviews, so they will be released in our 
mag in German language, and in yours for the rest of 
the world :) For that, we would be very happy if you 
could send us one or two texts out of your coming or 
older issues every two months or so (and I will 
translate and publish them in our mag). Also, other 
articles could be exchanged.That's pretty much it. 
What do you think of this idea? Are you interested?  
Some very old interviews are to be found on 
www.cevi-aktuell.de.vubut there are several newer 
ones I could send to you, latest one with aleksi eeben 
about his sid-project (emulation of sid-sound on vic-
20 and 6 voices on c64 ...) Kind regards, 
Commodore Free 
Boris Great to here from you yes I am interested 
in articles and doing a trade, I replied personally 
with some articles to Boris on this email  
I also pointed out that Commodore free is edited 
and run by just myself, its difficult to find 
information for the magazine and every issue I 
plea for links or potential magazine material, I 
also would like to cover all Commodore 
machines but my c64 is now my dominant 
machine.  
 
jeff 
Hello, i read your latest magazine and thought maybe 
you could help me.  I want to buy an injet for my 
commodore 64, but i rarely use geos.  what is the 
bestinkjet for me to buy to use with a parallel 
interfaceand be able to print from normal commodore 
programs in native mode without geos? 
Commodore Free 
Jeff the only thing I have used with a native 
Commodore 64 and a standard printer is 
something like Super Graphix these connect to the 
expansion port of the Commodore and have 
jumpers to set various things, one is to convert 
PETSCII to ASCII (commodore text formatting to 
standard text ) I have used the device from many 
applications on the Commodore 64 and to a 
variety of printers. The printers usually have to 
support Epsom standard most do and have 
tested such a device with Hewlett Packard 640c 
850c Laserjet 5 and laserjet 5si all worked without 
problems, even printing out disk listings.  
 
Anyone else like to comment? 

 
Cincinnati Commodore Computer Club 
 
From: Cincinnati Commodore Computer Club  
Subject: Cincinnati Commodore Computer Club 
Spring Expo 2007 May 5&6, 2007 
Date: Sun, 28 Jan 2007 10:37:13 -0500 
 
Spring Expo 2007 Ft. Mitchell, KY Across the Ohio 
River from Cincinnati, OH USA General Expo 
Information C=4 is planning a super weekend for 
your expo activities! The Expo will be held on 
Saturday, May 5th; from 9:00 am until we decide to 
call it quits on Sunday afternoon! We understand 
some of you are early birds; some of you are night 
owls.  
 
We will let the demo folks tell us when they want to 
present their demo! Over 30 hours of official 
Commodore activity the entire weekend! With a room 
the size of 2352 square feet, we are able to have 
demos and shops in the same room, nobody will 
miss a thing. Even though the C=4 Expo is in 
Kentucky, it is just across the river from Cincinnati, 
Ohio. The C=4 expo will be held at the Drawbridge 
Inn located at 2477 Royal Drive in Ft. Mitchell, 
Kentucky. The Greater Cincinnati Airport is a short 
distance from the hotel. Airport shuttle service is 
available courtesy of the hotel. Demonstrations and 
Speakers Commitments from guests will be posted 
when they are confirmed: Local tourist sites are also 
nearby: http://www.drawbridgeinn.com/directions.asp 
It is hoped that every Commodore Club can send a 
representative to experience the fun that expos 
create on a regular basis. The community welcomes 
like-minded hobbyists, and it is your best opportunity 
to meet folks you have yet to meet in person, or meet 
again friends you have met in the past.  
 
Spring Commodore Expo 2007 Reservation 
Information We hope you decide to spend the entire 
weekend with us and make it a great weekend 
starting on Friday night with your Commodore friends 
who decide to show up early. Hotel Information The 
Drawbridge Inn is located off I-75 and I-71 in Ft 
Mitchell Kentucky. The cost of the single rooms in the 
main building is only $69 plus taxes. The hotel is 
setting aside 10 rooms for our group until April 4th. 
After that date, any remaining rooms in that block are 
released for general sale. Reservations will continue 
to be accepted for our group at the quoted group 
rate, on a room available basis.  
 
To make reservations for the C=4 Expo: Name of the 
Event: Cincinnati Commodore EXPO Toll Free: (800) 
354-9793 In Kentucky: (800) 352-9866 (859) 341-
2800 There is an International Airport located nearby, 
with shuttle service provided by the hotel. 
 
 Expo Pricing Door Charge: $10.00/person or 
$15.00/family Selling Tables: $15/ table or $35/ 3 
tables (The hotel charges $10 in addition per table for 
power usage) Tables are 6' in length. All sellers and 
demonstrators need to set up before 9:00 on 
Saturday morning, the doors (for these only) will 
open at 7:00am.  
 
Contact Roger Hoyer by phone, email, or in writing. 
Email: thunderbird@iglou.com C=4 Expo c/o 31 
Potowatomie Trail Milford, OH 45150 
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News
 
Star Commander 
A new beta of Star Commander is out. For the 
changelog see below. Probably the most interesting 
improvement is that SC can now access cbm4win 
under Windows NT4/2000/XP/2003. So there is no 
more need for GiveIO and alike. Simply select 
"OpenCBM" as cable type at the transfer options 
dialog. OpenCBM needs to be installed for this of 
course. 
 
Since this is a beta release, there still might be bugs. 
Please send bug reports to the Star Commander 
Mailing List at sclist@yahoogroups.com. 
 
As usual, the new beta is available at 
http://sta.c64.org/scbeta.html. 
 
Changes in SC 0.83.21 beta since SC 0.82: 
 
Fix: During file rename, already existing target files 
are now detected correctly under operating systems 
other than real DOS, as well. 
Fix: The number of sides is not detected for disks in 
1570 drives anymore. 
Fix: The progress indicator counted blocks incorrectly 
while copying a file from a Commodore drive in 
normal transfer mode. 
 
New: Introducing support for accessing Commodore 
drives via the OpenCBM driver (cbm4win 0.4.0 or 
above) under Windows NT4/2000/XP/2003 - use the 
"OpenCBM" value for the "Serial cable" option in the 
"Transfer options" configuration screen. 
 
http://sta.c64.org/scbeta.html. 
 
 
DiskImagery64 0.6 released 23:17   
DiskImagery64 is a portable (Qt 4.2.x-based), open-
source D64 disk image editor for Mac, Linux and 
Windows. It offers a nice GUI with drag-and-drop 
support between disk images and the local file 
system. Runs programs or mounts images directly in 
your favorite emulator. 
 
Release 0.6 added network support: Download 
programs or share disk images as NetDrives with a 
single click to a real C64 with RRNet and The Final 
Replay ROM 0.6.Check it out:  
 
http://www.lallafa.de/blog 

 
 

BalSys v3.0 
 
BalSys v3.0 - Valentino Zenari released a new 
version of BalSys. 
 
 BalSys is a language, and development system 
package designed for C= Plus/4 (or expanded C= 
16). Based on the B.A.L. (Business Assembler 
Language), an existing standard for business 
machines, the environment has been improved with 
many high-level new commands and features. The 
package is a complete all-in-one tool: Editor / 
Debugger / Executer 
 
http://www.cbm264.com/svs/svsindex.html 
 
 
 

 
Win UAE Amiga Emulator 
WinUAE 1.3.4 (30.12.2006) 
========================= 
Bugs fixed: 
 
- Improved bsdsocket emulation stability 
 
- Winuaeclipboard crash fix 
 
- Windows Vista compatibility problems fixed 
 
- Filesystem flag handling on FAT volumes 
 
- Page Down-key Input panel remapping works 
properly 
 
- Sound system improved 
 
- ECS Denise/AGA borderblank feature works 
properly 
 
- Dualcore/SMP random freezes properly fixed 
 
and more minor fixes.. 
 
Bugs introduced in 1.3.3 fixed:   
- AVIOutput out of sync fix 
 
- CPU emulation condition code fix 
 
- Fixed handle leak in bsdsocket and AHI 
 
- Sound pitch shifting in VSync-mode and more.. 
 
- Catweasel MK4 mouse support 
 
New features: 
- Improved emulation of AGA sprites outside display 
window 
 
- uaeserial.device introduced. Multi-port serial device, 
unit numbers 
  are directly mapped to PC serial ports (unit 0 = 
COM0, 1 = COM1 etc..) 
 
- Improved serial port detection, virtual devices also 
supported 
 
- Improved Catweasel MK3/4 support without 
Windows driver installed 
  (requires TVicPort, 
http://www.entechtaiwan.com/dev/port/index.shtm) 
 
- Improved debugger features 
 
- Sound system is not anymore reinitialized when 
losing/gaining focus 
 
- 1M (1024KB) ROM image support 
 
- Sound volume configuration setting also sets AHI 
audio volume 
  (previously was Paula audio only) 
 
- Custom chipset interrupt timing improved 
And more.. 
 
http://www.winuae.net/ 
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AmigaAMP 
a powerful realtime MPEG audio player for Amiga 
computers. It is based on the amp decoding engine 
by Tomislav Uzelac and can do realtime decoding on 
50 MHz processors and up. AmigaAMP is a 
completely free and non-commercial project. 
Fraunhofer IIS and THOMSON multimedia grant a 
free license to use their MPEG Layer-3 audio 
compression technology for this kind of software.  
  
GadTools rules! 
The player comes with a fully fontsensitive, style 
guide conformous Amiga GadTools user interface 
and features multithreaded non-blocking windows for 
main interface, stream information and playlist.     
WinAMP looks nice, too! 
Too dull? Well, the same executable can be made 
look and behave like WinAMP just by ticking a 
checkbox in the configuration window. It can load all 
the WinAMP skins and can display a realtime 
spectrum analyzer.  
680x0 Realtime Decoding 
 
AmigaAMP can do realtime decoding even on slower 
680x0 processors using Stephane Tavenard's highly 
optimized mpega.library. On a 68040-40 you can 
play Layer3 at half the sampling rate and with 
reduced quality. Full quality and sampling rate can be 
archieved with a 68060-50.  
    
PowerUP and WarpUP Compatible 
In addition to the 68k decoder AmigaAMP comes 
with two PPC native decoding engines one for 
PowerUP and one for WarpUP. Both engines feature 
high quality realtime decoding of Layer2 and Layer3 
streams, graphic equalizer settings and full 
visualisation. 
On a PPC604e-200 you can play two 128kbps 
Layer3 streams with equalizer switched on and 
crossfade between the two without taking much CPU 
load! The realtime analyzers will continue to run 
smoothly without any latency problems at all.  
   
AHI Compatible 
AmigaAMP uses the widespread AHI Audio System 
at device access level. You can use it with any AHI 
compatible soundcard as well as with the original 
Amiga audio chipset.     
 
Current Features (v2.18)  
MPEG Layer-2, Layer-3, AIFF, and WAV playback  
MPEGit and MAS-PLAYER hardware accelerator  
 
support  Visualisation plugin system  
 
GadTools based font sensitive user interface  
Alternatively WinAMP compatible user interface  
Workbench application (Drop icons on window) 
AHI device-level access (uses default audio mode 
automatically)  
 
PPC (PowerUP and WarpUP) support  
AmigaOS 4 support  
 
ID3 tag editor (artist, title, album, etc.) and ID3v2  
 
Playlists and Repeat mode  
Volume, panning and crossfading  
Editable playlists and shuffle mode with skin support  
 
Graphic equalizer  
Shoutcast/Icecast internet radio support  
Planned features MPEG decode-to-file  
 
 

Cottonwood BBS 
I've recently aquirerd a CMD HD-200 hard drive 
(thanks, Al!), as well as a couple 1581's (thanks, 
Marco!), and with this, I've vastly improved the setup 
for my BBS. Until I get the update for AA BBS  
from its author, I'm only able to have one 16 MB 
partition of the 245 MB hard drive on the BBS, but 
even so, this is a VAST improvement over what I was 
running. And now, I can officially announce quite  
happily that I have DIVORCED my C=64c from the 
PC it was connected to. Everything is now 100% 
original! 
 
I've updated the photo of my setup on the 
Cottonwood BBS website at  
 
http://hometown.aol.com/cottonwoodbbs 
 
Here's what the BBS is now running on: 
 
1 Commodore 64c Computer 
1 Commodore 1084S Monitor 
2 Commodore 1541 Disk Drives 
1 Commodore 1541c Disk Drive 
1 FSD-2 Excellerator+ Disk Drive 
2 Commodore 1581 Disk Drives 
1 CMD HD-200 Hard Drive (245 MB) 
1 MultiTech MultiModem224 (2400 baud) 
1 Black Rotary-Dial Desk Phone 
1 All American BBS by Nick Smith 
 
Check it out now at (951)242-3593. Call and 
experience the world's last remaining Commodore 64 
dial-up BBS! 
 
-Andrew(aka Balzabaar - SysOp) 
http://hometown.aol.com/cottonwoodbbs/ 
 
Information from the WEBSITE  
+1 (951)242-3593 
 
Located in Moreno Valley, California, USA. 
 
Operating 24 hours a day, at 300/1200/2400 baud. 
Running on a Commodore 64 with All American BBS 
Possibly the only remaining Commodore dial-up BBS 
in the world! 
 
For the best experience, call from a Commodore 
computer with a Color Graphics terminal program. To 
download CCGMS 5.5 (my personal favorite),  
For the best Commodore graphic experience on a 
PC, call using C64Term by Greg Pfountz. To 
download C64Term,  
  
NOTE: This terminal runs in DOS using a standard 
Hayes Compatible modem. This will not run in 
Windows, nor will it work with a "WinModem".  
 
For the least desirable experience, you can connect 
in ASCII mode using HyperTerminal in Windows. 
Please note that "modern" modems take longer to 
connect than a modem on a Commodore computer. 
Because of this, the BBS may not appear to be doing 
anything when you connect with HyperTerminal. 
Once you've connected, just press enter, and the 
BBS should "see" you. If you get garbled 
charachters, the BBS may have detected you as 
connecting at the wrong baud speed. In this case, 
just disconnect and try calling again. The default 
settings in HyperTerminal should work fine. 
 
drewbrasil@yahoo.com.br. 
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Cottonwood BBS 
 
Well... I did it...  I've toyed around in the past with 
switching to Color 64 software on my BBS.  But, I've 
held off in hopes that the "updated version" of All 
American BBS would have support for my CMD hard 
drive.   After much waiting, I've finally received that 
update.  However, much to my dismay, I discovered 
that it has full support for Lt. Kernal and ICT Data 
Chief hard drives, but NO support whatsoever for 
CMD hard drives.  Well, that discovery spelled the 
end of my association with All American BBS.  
 
 I will still be releasing the final versions of AA BBS 
for the 64 and 128, as well as the source code for 
each, to the Public Domain on Nick Smith's behalf, 
for anyone who is interested in these programs.  
More to come on this... 
 
So it's happened, and Cottonwood BBS is now 
running on Color 64 v7.37.  This was the final version 
written by Greg Pfountz, Color 64's original author.  
I've got a very basic setup right now, but I have *full* 
hard drive support, and all 240 MB are now online, 
with 26 directories of Commodore goodness.  :-) 
 
I'll be working in the coming weeks at transferring 
much of my software collection to these directories, 
as well as contributions from former Commodore 
BBS SysOps that are on their way to me.  I'll also be 
adding some online games, and basically doing 
some general "sprucing up" of the BBS. 
 
So check out Cottonwood BBS today at (951)242-
3593, and enjoy the "new look".  :-) 
 
-Andrew (aka Balzabaar) 
   ___  
  / __|__   Cottonwood BBS 
 / /  |_/   +1 (951) 242-3593 
 \ \__|_\   Open 24/7 at 300/1200/2400 baud 
  \___|     http://hometown.aol.com/cottonwoodbbs 
 
IDE 64 
 

Happy New Year from the IDE64 staff. 
Hopefully we will release IDE64 V4 later this 

year! 
 

Thanks for the patience to all who asked as 
about the IDE64 availability and did not get 

answer yet. 

 
 
 
 
 

 

The Innercircle BBS 
 
After several months of preparation, The Innercircle 
BBS is online!!!   
 
 Telnet://innercirclebbs.com   
 
today!!  ANSI, C/G Mode, etc... 
  
Running on  
a C= 128D,  
SCPU (20Mhz), 
 RAM Link,  
CMD 4GB HD,  
115,200 baud.   
Modified Centipede BBS. 
  
I've put a lot of work into this and hope it becomes a 
favorite amongst everyone. 
  
Lots of files and message bases!! 
  
Spread the word! 
Thanks! 
  

telnet://innercirclebbs.com 
 
 

Retro Vision 
Retro Vision 2007 
 
International LLamasoft Jolly 
 
 
Retro vision is a PRIVATE event for members of 
YAKYAK and selected guests from other forums. 
No General Public 
 
The event is pub based and will use 3 areas aiming 
to run 20 machines at least 1 cab and a large 
projector screen. 
 
11th -13th May 2007  
Port Mahon 
St. Clements 
Oxford 
 
Friday Opening times 12 midday to 1am 
Saturday Opening times 12 midday to 1am 
Sunday 12 midday – Handhelds only 
 
Ticket booking http://www.retrovision.org.uk/ 
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LOADSTAR ANNOUNCES 
DOTBASIC PLUS 

 
DotBASIC Plus (DB+) is a new software development 
system that makes  mouse controlled programming 
on the C-64 a snap -- even for those who only know 
BASIC 2.0. Over 90 commands are available in the 
DotBASIC  Library -- from Print At to Multi-Select 
Scrolling Menus to worry-free bitmap  graphics and 
SIDPlayer music. 
 
The mouse, and all the information the mouse can 
generate, is  built-in. And Do-Loops makes using the 
mouse extremely easy. Add pull-down  menus, roll-
over buttons, and dialog boxes to make your C-64 
act like a brand new computer. 
 
Most BASIC Enhancements require loading and 
running a system program  which reconfigures the 
machine. Only then can you load your own program 
and use the extended commands. DB+ loads and 
runs on a default C-64.  And when the program is 
finished, a simple command returns all pointers  to 
BASIC 2.0. 
 
Moreover, DB+ includes only the commands you 
need for your project.  Like "big-time" languages, 
each command is a stand-alone programming  object 
linked to your DB+ code as you develop your project. 
If you want  bitmap graphics or SIDPlayer music, 
memory is automatically set aside. It  such are not 
necessary for your work, the memory is open for 
other  uses. 
 
The powerful Rack command turns a text file, 
bloaded under ROM, into a  virtual array. And 
.PUTSTR allows string data to be tucked under ROM 
or  even I/O and quickly indexed for use in your 
program. Sprites are fully  "objectified," with full 
control and reporting from one multi-function  DB+ 
command. 
 
The project-creating program, B.DOTBASIC, puts 
everything you will  need on your work disk using the 
name of your project -- then loads and  runs the the 
"template" program. Add commands in the same way 
you "include" files in C or C++, linking them to your 
DB+ code with B.DEV, which  collects the needed 
program objects, saves the file to your work disk,  
then loads and runs your program.And, at any time, 
you can list all the commands currently available in  
your DB+ program. Every command is "self-
documented" with syntax information that's just a 
SYS away. 
 
Since DB+ uses program objects, the list of 
commands in our library  (now at 90) is limited only 
by the imagination of ML coders. Each command  but 
be fully relocatable, but one object can "call" another. 
Several commands can share data. And local data is 
easy to use -- even in  relocatable code, thanks to 
the DB+ system. 
 
DB+ will premiere on LOADSTAR 248 (probably 
available the first week  in March), with a "beginner's 
library" of commands. In subsequent  
issues, other program objects and utilities will be 
published to give the full power of the C-64 to BASIC 
programmers. 
 
Those interested can get a D81 download of the 
current library and system from just $8 (US). PayPal 
to revdave6@aol.com, and put "DB+" in the 
description area. 
Dave Moorman 

HOBBYIST PROGRAMMING: 
THE JOY OF C-64 
by Dave Moorman 

 
For some, the C-64 is a badge of independence from 
the every new commercial consumer computer 
market. For others, it is a marvelous excursion back 
to a simpler time of computing. For me, the C-64 is 
my domain, where I can create anything I can 
imagine. 
 
I am a hobbyist programmer and have been since 
July 3, 1979. I enjoy telling bits and bytes exactly 
what to do. And there is no better place  
to do it than on a C-64. 
 
First of all, BASIC 2.0 is an easy language to grasp. 
Anyone with a mind for logic can make great things 
happen in BASIC. True, BASIC 2.0 lacks some 
commands that would more fully exploit the potential 
of the C-64. But then again, such a limitation can be 
overcome by advancing to a BASIC Extension (like 
DotBASIC Plus), or learning some simple POKEs,  
PEEKs, and SYSes. BASIC 2.0 does not trap the 
programmer -- it taps the programmer's 
understanding of the incredible resources available in 
the stock machine. 
 
Then, one can advance into the world of "modules," 
4-7K chunks of ML that put boxes on the screen, do 
menus, play music and sound effects, display and 
draw bitmap graphics, and even perform split-screen 
effects. LOADSTAR has published a great number of 
such toolboxes and other modules, and all that is 
needed is some understanding of memory 
management and a willingness to read and 
experiment. 
 
The final frontier is machine language programming -
- writing in DNA! The simplicity of the instructions 
forces very careful logic. But with ML, I have 
Absolute Power over my computer. No one stands 
between me and the machine! But, my experience is 
that Absolute Power comes with  Absolute 
Responsibility. When the machine does exactly what 
I told it to -- as opposed to what I wanted it to do -- I 
have no one to blame but myself. 
 
And it is this essential Responsibility that is so 
needed in the world today. Our public schools teach 
the mechanics of keyboarding, word-processing, 
spread-sheeting, and other "useful" tasks. And as 
preparation for work out in the real world, this is quite 
right and proper. But there is a creative magic in 
programming that seems to be missing in our  
kids' environment -- a lack of imaginative exploration 
and, as Bill Gates called it, the joy of unequivocal 
success. 
 
For nothing one can do alone feels as good as 
grinding through dozens of really pissy logic 
problems until the code works exactly as desired.  
And when that happens, the programmer knows real 
JOY! 
 
And while this is true for programming on any 
computer, the C-64 is the perfect place for the 
devoted hobbyist. It is big enough to do (or at  
least model) anything computational, yet is blessed 
with a tidy finitude. Programming on the C-64 is like 
writing a sonnet or haiku. The limitations demand 
greater skill and thought. And the results are, at the  
very least, loaded with the joy of unequivocal 
success! 
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DirMaster v1.0a/Style 
by The Wiz 

 
Introduction 
 
In the 21st century much of the Commodore 64 as 
been ported over to the MS-DOS and Windows 
world. Disks are represented in single files using 
D64, D71, D81 formats, among others. One could 
boot up a C64 emulator, load a directory editor or file 
copier, and edit these disk representations or 
move/copy files between them. But, unfortunately, 
the Commodore 64 has many drawbacks that don't 
exist in the Windows world. Wouldn't it be easier to 
manage your disk collection in a windowed 
environment? 
 
Of course, DirMaster is not the first Windows-based 
GUI tool for CBM disk image manipulation. But we 
feel it stands among the very best, pushing the 
capabilities again into the future with features like:  
full D64, D71, and D81 support!  
 
integrated with Explorer via file associations/icons  
open literally *hundreds* of images at the same time  
fully working drag and drop between disk images:  
copy or move a file from one image to another  
copy between different image formats (e.g. d64 to 
d81)  
 
move/reorder files on the same disk by dragging 
them drag and drop classic 'separator' entries onto 
your disk image 
  
drag files from Explorer onto disk images to import  
user friendly BAM view with track/sector view/edit; 
BAM view fully supports standard error-track 
extensions  
 
all the usual directory editing capabilities...  
most functions activated by keyboard equivalents, 
including file reordering and filename editing  
a multi-level undo capability  
 
working just fine under WINE for 
Linux/FreeBSD/Solaris freaks  
As a first version, DirMaster already surpasses... as a 
tool we aim to fully improve according to user 
feedback, the limits are oblivious.  
Installation 
 
Install DirMaster using the setup.exe; after 
installation you can locate a DirMaster shortcut on 
your desktop or in your your "..\Program 
Files\Style\DirMaster" directory. An updated, 
improved CBM font file is also included in the 
installation and placed in your system fonts folder. 
File associations will be made automagically, 
mapping all .d64, .d71, .d81, and .seq files to 
DirMaster.  
 
Making a new disk... 
Functionality: New Disks 
To create new blank disks (either D64, D71, or D81) 
use the sub menu: "Disk->New". Keyboard 
equivalents are 6, 7, and 8 respectively. The new 
disk function only open a new disk image inside 
DirMaster itself - at this point the image has not been 
saved to disk.  
 
Functionality: Open/Save 
 

 

 
To open existing disk images, use the "Disk->Open" 
menu item. Alternatively, drag and drop disk images 
from your file manager onto the DirMaster window. 
You can drag and drop multiple images of any type 
(D64, D71, D81) to open them all at once. You 
should be able to have literally several hundred disk 
images opened at once, although memory usage will 
rise accordingly. Finally, double clicking a disk image 
in your file manager should open that image in a new 
instance of DirMaster.  
 
As soon as you make any change to a disk image, 
the image window title bar will update with an 
asterisk to indicate an edited but unsaved image. 
You can save the image using either the "Disk-
>Save" or "Disk->Save As" menu items.  
Functionality: Directory Editing 
Directory editing operates as a WYSIWYG mode, 
allowing you to type in a full range of CBM characters 
including special graphics symbols, although most 
unprintable control codes (such as color codes) wont 
actually alter the displayed the directory (i.e. actual 
colors and cursor movements). Use of the cursor 
keys (up/down) allows selection of different files in 

the directory listing.  
 
The right-click menu over the directory display... 
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Most operations regarding manipulation of single files 
can be found under the main "File" menu. To edit a 
filename, select "File->Rename" or simply press 'e' to 
enter edit mode for the currently selected file. In the 
edit mode, cursor keys (left/right) allow selection of 
individual characters. The 'insert' key toggles 
character over-strike or insert modes, and the cursor 
updates to reflect the current mode. The filename 
can be left or right aligned (using the 'l' and 'r' keys), 
centered ('c'), and expanded ('x', which pads the 
current filename with spaces out to 16 characters). 
While in edit mode, 'backspace' and 'delete' keys 
also operate as you would expect.  
 
Aside from filename editing, the file type may be 
altered using the sub menu "File->File Type"; valid 
types being PRG (also set with the 'p' key), SEQ ('s'), 
USR ('u'), REL ('r'), DEL ('d') and CBM. Finally, files 
can be locked (the '<' key) and splatted ('*') and the 
file size can be altered or auto-sized (DirMaster will 
trace the file links and set the filesize to the actual 
size, if different).  
 
File positions can also be altered by using the mouse 
to drag and drop file entries above or below other 
files. For keyboard fans, files can also be moved by 
holding the shift key down on the file you wish to 
select, and then using the cursor up/down keys to 
move that file.  
 
An entire file entry can be deleted by using the "File-
>Remove" menu item or by hitting 'delete'. Note: 
DirMaster will reset the BAM to reflect the deleted file 
entry, but it leaves the actual sector data intact! To 
wipe all free blocks on the disk, use the "Disk->Fill 
Free Sectors" item. Disk related data including disk 
name and disk id can also be edited by using the 
"Edit->Rename Disk" and "Edit->Edit Disk ID" menu 
items respectively.  
 
Please note that almost all functions related to file 
and disk editing, as well as exporting files, can also 
be accessed by clicking the right mouse button over 
a file entry.  
 
Functionality: File copy/move/import/export 
With DirMaster, copying and moving files between 
disk images is as easy as dragging and dropping the 
file between any two opened images. You may 
copy/move files between different image types, like 
from a D64 to a D81. When a file is copied, the file is 
written to the destination disk using a standard sector 
interleave and the destination BAM is updated 
accordingly. When a file is moved, after the copy is 
written to the destination as described earlier, the 
source disk is updated as if the file had been deleted: 
directory entry is removed, BAM is updated, but file 
data remains intact.  
 
To export a file from a disk image to the host file 
system, use the "File->Export" menu item. When 
exporting a PRG file, the exported copy retains the 
two-byte load address. When exporting a SEQ file, 
the exported copy will be written using a PETSCII 
character set unless the "Convert to ASCII" checkbox 
in the file save dialog is checked, in which case, 
obviously, the file is translated into a standard DOS 
ASCII format.  
 
Importing a file, oddly enough, can be accomplished 
with the "File->Import" menu item. When importing a 
text file, check the "Convert to PETSCII" checkbox to 
perform an ASCII to PETSCII translation. Finally, files 
can be dragged from your file manager and dropped 

onto an open disk image in DirMaster. This 
accomplishes the same outcome as importing.  
Functionality: Undo 
DirMaster keeps track of multiple undo points for 
each open disk image. Use 'CTRL+z' to invoke the 
undo function (or invoke it using the "Edit->Undo" 
menu item). Since undo tracks changes on a per 
image basis, be aware than invoking undo 
immediately after a file move, for example, will only 
roll back the change to the current disk image. To 
fully reverse the move operation, you would invoke 
undo once each on both the source and destination 
images.  

 
BAM Editor from a .d64... 
 
Functionality: BAM Editor 
The DirMaster BAM editor can be invoked using the 
"View->BAM Editor" menu item. You may open one 
BAM editor per disk image, and you may have 
multiple BAM editors open at the same time. To 
avoid confusion, check the title bar of the BAM editor 
window - it will reflect the same filename as the disk 
image it corresponds with. Furthermore, the BAM 
editor displays the actual disk image name and id at 
the top of the window.  
 
The BAM editor displays a track/sector map where 
green represents unallocated sectors and red 
represents allocated sectors. Sector errors, if this 
option is enabled (see "Disk->Extensions->Sector 
Errors"), will be displayed as an overlayed number 
corresponding to the CBM error code (e.g. 23 for 
checksum error). The BAM editor will look slightly 
different for each different image type, varying by 
both the number of tracks (represented as rows) and 
sectors (represented by tracks). Otherwise all BAM 
editor operations work identically across image types.  
In the BAM editor, right clicking will ordinarily toggle 
the status of the sector in the BAM between allocated 
and unallocated. The exception to this is when the 
Sector Errors option is turned on.  
 
Then, right clicking brings up a context menu that 
allows you to toggle an individual sector as well as 
allow you to set a disk error (one of 20, 21, 22, 23, 
25, 26, 27, 29) on the selected sector. Note: Disk 
images with sector error information can have two 
possible formats: one in which error is represented 
as a byte whose value corresponds to the actual 
error number (e.g. 23) and one in which the error is 
represented by some other format specific code 
value. DirMaster will support reading of either 
version. To write disk images in the former mode, 
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turn on the "Disk->Extensions->Write Error Numbers" 
feature. To write disk images in the latter mode, turn 
that feature off. 
 
The BAM editor may also be invoked by using the 
"Edit BAM" icon in the toolbar immediately below the 
main menu.  
 
Functionality: Sector Editor 
To invoke the sector editor, simply click a BAM entry 
(a green or red disk corresponding with a given 
track/row and sector/column). A sector editor opens 
up, which like the BAM editor will reflect the disk 
image file name in it's title bar. The operation of the 
sector editor is fairlystraightforwardd... use the cursor 
keys to navigate and select individual bytes; then 
change the value or the byte. Editing can be done on 
either the left hand side hex representation (which 
accepts valid hex input) or on the right hand side 
PETSCII representation, which allows any PETSCII 
value. 
 
 Note: changes are taken immediately - there is no 
"save" option in the sector editor. However you may 
use the undo function to rollback multiple consecutive 
changes.  
 
Press the 'j' key (or 'Alt-Down') to follow the current 
sector's 'next track/sector' link, if it is valid; 'Ctrl-
Right'/'Page Up' and 'Ctrl-Left'/'Page Down' 
increment and decrement the sector; 'Ctrl-Down' and 
'Ctrl-Up' increment and decrement the track; 'Page 
Up' and 'Page Down' will move to the previous or 
next sector; finally, 'Alt-Left' and 'Alt-Right' will swap 
the cursor between the current hex and PETSCII 
byte.  
 
CBM Tool... 
Functionality: CBM Tool 
The CBM Tool, invoked using "View->Show CBM 
Tool", displays an entire set of CBM characters. Use 
the CBM tool when editing a filename, disk name, 
disk id, or sector to insert/over-strike characters: 
while editing, click a character in the CBM tool and 
this has the same effect as if you typed it using the 
keyboard.  
 

The CBM Tool may also be toggled on/off by using 
the "Show/Hide CBM Tool" icon in the toolbar 
immediately below the main menu.  
Functionality: Separator Tool 
 
The Separator Tool, invoked using "View->Show 
Separator Tool", provides a collection of common 
directory file names which provide the typical 
'separator' style directory entries that became so 
ubiquitous among scene releases. While the 
Separator Tool is open, you may drag entries from it 
onto disk images to place separators in the directory.  

You may also edit entries on the Separator Tool by 
right clicking the mouse over any entry. You can 
move entries up and down to reorder the list; you can 
edit individual entries in place, you can delete entries, 
and you can add new entries. All changes you make 
will be saved for the next time you use DirMaster.  
 
The right-click menu over the Separator Tool... 
The Separator Tool may also be toggled on/off by 
using the "Show/Hide Separator Tool" icon in the 
toolbar immediately below the main menu.  
Functionality: Miscellaneous 
SEQ files can be viewed by selecting a SEQ file and 
pressing the 'v' key, by selecting the "File->View File" 
menu item, or by invoking the same item from the 
right click context menu.  
 
On most windows including disk images, SEQ files, 
and the sector editor, the CBM character set case 
can be toggled using "View->Toggle Case" or by 
clicking the "Toggle Case" icon in the toolbar 
immediately below the main menu.  
 
While selecting a file on a disk image, press the 'j' 
key or select the "Jump to Sector" item in the right 
click context menu to immediately open the sector 
editor and jump to the first sector of the selected file.  
 
Extensions menu... 

Extended track disk images can be loaded and saved 
when the "Disk->Extensions->Extended Tracks" 
feature is enabled. With extended tracks, a D64 
image with tracks 36 to 40 can be manipulated and 
saved. However, other than direct sector and BAM 
editing, the extra tracks are not currently supported 
when copying/writing files. 
  
Credits and Contact 
DirMaster was coded by The Wiz/Style with testing 
by the entire Style crew. Please find contact 
information on the About panel inside the app, or 
leave us feedback We would greatly value your input 
as to future versions of this tool - let us know what 
you want!  
 
http://www.style64.org/index.php?cid=rele.dirmaster 
 

Tried to email the website in order to be able to 
print this information but received no reply
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Commodore Free Interview with 
 Ron van Schaik from the Dutch Commodore club 

 
 
>who are you and what do you do? 
 
My name is Ron van Schaik and I am chairman of 
the Dutch Commodore Club 
If you wanna know who I am, you can find a picture 
on the page  
 http://commodore-gg.hobby.nl/okt2006col7.htm 
 
I am the one who's being interviewed by television 
and this link you can  find here:  
 
http://video.google.nl/videoplay?docid=-
4814625904960876672&q=retro+computers 
 
>I came across the site by accident, is this 
normally how people find your website? 
 
 I don't hope so.....I lot of well known sites have a link 
to our website. Also 
for example our 
calendar is on the 
C64 portal and the 
biggest Amiga sites. 
Also I post often 
news on the 
different news 
portals about what 
we are doing. 
 
>HCC - 
Commodore GG 
what does this 
stand for? 
 
HCC= Hobby 
Computer Club (It's 
the biggest 
computer club of 
the Benulux  with  
170,000 members) 
There are a lot of 
groups in this HCC, 
like DOS, 
Multimedia,  
Flightsimulator  
and we!!! GG 
stands for: 
Gebruikers Groep, 
this is in English: 
user group 
 
>>how did the 
club start 
 
Our club started in the mid eighties when the 
Commodore computers were  like  a virus in Holland 
Now we organize 6 times a year a C= Show in the 
Trefpunt, Maarssen,  Holland.  Most C= Shows we 
have a theme, like in february Innovation.  
We  demonstrate  than the MiniMig, The 1541-III and 
the 1541 ultimate. Also we had  themes  like Retro 
Game and Computer Party with all other retro 
computers, Tinker  workshop, SID music etc.  

 
 
 
 
Also we participate with some members at other  
Retro Game and Computer expos and we organize  
sometimes a C= Show in an  other part of Holland or 
Belgium.  You can find a lot of photo's about  this  on 
our report pages and for coming C= shows you can 
look at our calendar.  All this is a lot of work and we 
are now leading our club with around eight  guys. 
 
>do you pay to be a member 
 
Yes, you pay 10 euro per year. You are allowed than 
to participate  (active)  on our clubmeetings (it's no 
problem to come and see for the first time  for  free). 
Also you can go to the HCC Computer Beurs (the  
biggest computer  Expo  in the Benelux) for half 
prize. We are participating there every year  as  

well. You 
can use our 
"helpdesk" 
and more. 
 
>what is the 
clubs 
function 
 
 
To have 
contact with 
other 
Commodore 
and Amiga 
users, 
collectors,  
gamers  
etcetera. To 
help each 
other with 
problems, 
repairs, 
programmin
g and  
hardware. 
We have 
every C= 
Show a table 
with stuff for 
free and you 
can  buy  for 
little prizes 
more usefull 
things (this 
is for our 

club) 
 
>the clubs website has lots of information can 
you tell readers about what is on offer? 
 
We started a few years ago with an English part 
because we had more and more  vistors from abroad 
on our C= Shows. Now we have every week new 
news,  articles, information about the C= computers 
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and devices, manuals,  scans  from magazines and 
books etc.  
 
Very interesting are for example the  
pages  about Vice, CCS64, Innovation and C= 
computers  and devices for foreign  visitors. We have 
a lot of plans to make our website better and better  
in the near future. 
 
>what machines does the club support? 
 
All Commodore and Amiga computers 
 
>can you tell us a little of your personal history 
 
I started in 1986 with a C128D (always in C64 
mode...) and I sold it  and for  that money (and a little 
bit more) I bought an Amiga 500. Later on I bought a 
PC (486) and in the mid nineties I saw on a  
fleemarket a  C64 and that was the start of a flood of 
C= computers 
 
>>what Commodore machines do you own 
 
VIC20, C16, PLUS4, 232, a lot of different kinds of 
the C64, C64SX,  C128,  C128D, A500, A1000 
1400 original C64 games, 150 original C16 and 
VIC20 games, hundreds of  books  and magazines, 
all kinds of devices (a few boxed) 
 
>the website has both english and Duth 
primarily Dutch, are there plans to convert all the 
website to english 
 
The website is English and Dutch....... 
Mainly it will have to stay in Dutch because we're the 
only one, and that's I  think  important for our 
members (800) But it is our plan to convert the most 
in English! 
 
>>I see you have links to Commodore free 
magazine  that’s a good thing, do you have any 
comments on my work? 
 
I an very pleased about your work. It's great that 
there are still guys who are working at the popularity  
of  Commodore ! 
 
>the links to commodore free magazine have 
generated quite a lot of traffic, do you think 

people miss commercial commodore magazines? 
 
It's difficult to say because we have also a magazine 
and that was not a big success (as a paper 
magazine) Now we are distributing our magazine as 
a PDF file, and that's going a lot  better 
 
>what plans does the website and club have? 
 
We will try to have a leading role in Holland about 
everything what's  about  Commodore and Amiga 
Also we work hard at our innovation plans, a new guy 
is coordinating  this  now We are very proud that our 
clubmembers have build the MiniMig, the 1541-III  
and the 1541 Ultimate 
 
>commodore free has been plagued by copyright 
problems has anyone asked you to remove 
pictures or news from the website? 
 
 
No, we had no problems about this 
 
>how is the website funded? 
 
With the money from our members we pay the club 
building, the website, the printer, viewer and all that 
sort of things. We are part from a big Dutch 
Computer Club called HCC and those are supporting 
us too. 
 
>>thanks you for your time and efforts 
 
Also thanks and I wish you a lot of success with your 
work! Best regards Ron van Schaik 
 
On our webpage 
 
 http://commodore-gg.hobby.nl/persber.htm  
 
you can see all press reports of our club: newpapers, 
magazines and TV. 
 
You May also interesting is a peek at our magazine:  
 
http://commodore-gg.hobby.nl/download/IB1006.pdf 
 
Website and further information available from  
http://commodore-gg.hobby.nl/ 
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DTV Hacking
 

 
Here are a few pics of my own DTV Hummer project. 
I had an old PSOne LCD screen lying around and I 
thought I'd make a C64 laptop. Actually, it's more like 
a C64 PDA! It measures 6.5 x 6 x 1.5 inches (15.5 x 
16.5 x 4 cm) when closed. It can run from an AC wall 
adapter or 6 NiMH AA batteries.  
 
The keyboard is hacked from a portable folding 
keyboard for a Jornada PDA which outputs RS-232. 
I'm using a PIC 16F88 to decode the signals and re-
encode them to PS/2 (that was an ordeal to figure 
out).  
 
The PIC checks to see if an external PS/2 keyboard 
is connected on power up. If one is hooked up, it will 
route data from that instead. There is an internal 
ampilfied speaker as well as connections for audio 
and video output on the back.  
 
There's a serial connection for a disk drive and an SD 
card slot in the side for a 1541-III but I haven't been 
able to get that to work yet. I also have a connection 
for a userport/joystick. The joystick in the picture is a 
hacked Atari keychain joystick. The mini joystick 
wasn't in the original plan but after I accidentally 
discovered it on ebay, it seemed perfect. 
 
Here's a how-to post regarding the RS232 to PS/2 
keyboard hack: 
 
http://jledger.proboards19.com/index.cgi?board=dtvh
acking&action=display&thread=1167783024 
 
The Micro Folding Keyboard (Model#: TKB420HP) 
made by Micro Innovations is a small portable 
keyboard for attaching to a Jornada PDA. It basically  
 
 
 
has all keys needed for adapting to a DTV but 
unfortunately outputs RS-232 instead of PS/2. The  
 

 
following information describes 
how to interface this keyboard 
to DTV Hummer and possible 
the rest of  
the DTV versions. 
 
Out of the box: 
Disassembling the keyboard, 
you’ll see 5 labeled 
connections: VCC, RTS, RXD, 
DCD, and GND. VCC is +5V 
for this unit. RXD is the line on 
which data is actually sent, 
although the keyboard won’t 
send anything until RTS is 
pulled high. 
 
 I do this right on the board by 
soldering a 1k resistor between 
the RTS pad and the onboard 
microcontroller’s Vcc pad (see 
picture). By doing this, you only 
need to run three wires from 
the keyboard (VCC, RXD and 
Ground). 
 
As far as what mechanical 
modifications… I chose to cut 
away a lot of extra plastic from 

the two folding halves and superglue the sides 
together. This effectively created one solid piece. I 
also glued the flexi-ribbon flat against itself to take up 
less space. 
 
Since this keyboard outputs RS-232 (9600 baud, 8 
data bits, 1 stop bit and no-parity), a PIC 16F88 

microcontroller is used to convert the data to PS/2 for 
the DTV. PS/2 keyboards use “make” and “break” 
codes 
 
One or more “make” codes is sent when a key is 
pressed and several “break” codes and are sent on 
key release. The Jornada keyboard kind of works the 
same way in that it uses make and break codes, 
unfortunately the codes are not a one for one match 
and must be re-mapped by the PIC. 
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On power up, the PIC will check to see if a regular 
external PS/2 is attached. If so, it will just go into 
“repeater” mode and pass along any signals from the 
PS/2 keyboard to the DTV. The PIC adds a one 
second delay to get rid of the pesky “V”.  
 
Here’s the circuit: 
The diode and resistor on pin 4 are for in-circuit serial 
programming (ICSP) and can be left out as well as 
any other connections labeled ICSP. The 100k 
resistor on pin 11 is needed even if you decide not to 
mess with the external PS/2 connector, so don’t 
leave it out. The rest is fairly straight forward.  
 
The 100uF cap may need to be larger depending on 
your setup. 100uF worked initially for me until I added 
an LCD screen to my design. The power surge on 
start up was too much and the keyboard would not 
initialize properly until I increased it to 470uF. 
 
For timing, the internal 8 MHz oscillator is used. It 
seems to work just fine. 
 
Here’s the HEX file: 
www.picobay.com/picodore64/JornadaKB_16F88.he
x  
 
And the source code: 
www.picobay.com/picodore64/JornadaKB_16F88.txt 
 
Again, this is for a 16F88 and any $15 JDM PIC 
programmer will work just fine. The source code is 
written in PicBasic Pro. The code could probably be 
reduced to half the size by constructing the send 
codes on the fly instead of hard coding them.  
 
The start, stop parity bit could be added automatically 
and each make/break code would only take up a byte 
instead of a word. But the 16F88 has 4K of space 
and I wasn’t tight on space. Maybe as I add more 
features, I’ll recode that section. And while I’m at it, 
I’ll switch to using interrupts to get the data from the 
Jornada keyboard instead of just waiting for data. 
Obviously this is an adapted keyboard and I had to 
switch some of the key assignments: 
 
Today = ESC (RUNSTOP) 
Space = INSERT 
Windows key = Commodore Key 
FN + Right Arrow = HOME 
FN + CRTL + Right Arrow = CLR SCN 
 
The 4 keys in the top left are the F1 thru F4 keys, F5 
thru F8 with the FN pressed. 
 
I didn't bother to implement the Numlock keypad, 
there didn't seem to be much point to doing so. 
 
Just for the heck of it I’m posting the PS/2 waveform 
of a make code for the “A” key. Channel 1 is the 
clock and Channel 2 is data. 
 
 
This is from a real PS/2 keyboard. 
Here are the specs: 
Mainboard: Hummer DTV 
 
Construction: Hobby plywood covered in faux  
 
stainless steel contact paper 
 
Size: 6.5" x 6" x 1.5" (closed) 
 
Power: 7.5v wall adapter or 6 rechargable AA NiMH  
batteries 

 
Screen: 5" LCD Keyboard: 69-key QWERTY Sound:  
 
Ampilfied 1.5" 0.4W internal speaker 
 
Connections: power, userport/joystick, serial disk 
drive, audio/video output, headphone jack, external 
PS/2 keyboard, SD card slot. 
 
Addition peripherals: 1.75" x 1.5" mini Atari joystick. 
 
Features: 
 on screen display for volume and brightness control, 
auto sensing of external keyboard connection, 
programmable funtion keys, video selector switch. 
 
Although I plan on posting a more length write-up, for 
now, I'll give you just the important details: 
 
The LCD screen is from a PSOne. I'm also using on 
LCD's board audio amp to drive the speaker. 
 
The LCD is what ultimately drove my power 
requirements. Almost the entire circuit for the LCD 
uses 5v except for one IC which needs between 7v 
and 8v to generate H-Sync. 

 
The keyboard was a bitch to figure out and will be the 
subject of a post of it's own. It's from a Jornada 
foldaway keyboard made by Micro Innovations. In 
terms of construction, I had cut away a lot of extra 
plastic and superglue the two halves together making 
a single solid keyboard.  
 
The keyboard normally interfaces with a HP Jornada 
via a RS-232 link and special driver. I was able to 
capture all the output codes and program a 16F88 
PIC microcontroller to re-map and output with the 
appropriate PS/2 protocol. On power up, the PIC 
checks if there is an extrenal keyboard attached. If 
so, it ignores data from the onboard keyboard. 
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Interview with Piccadore 64 creator 
Jason Winters 

 
In a reverse of efforts Jason caught up with Commodore Free magazine, firstly to Commend my efforts, and 

also to tell me about his project. I then persuaded Jason to a small interview for the readers. 
Here is the interview. 

 
CF 
please tell the readers what is a Picodore 64 
 
JW 
 The Picodore 64 is a custom built C64 laptop based on 
the main circuit board from a DTV Hummer Off-Road 
Racing game (many thanks to Jeri Ellsworth).  The 
Hummer game was one of those joystick games that you 
connect directly to a TV.  The game wasn’t very good but 
it didn’t take long for the DTV hackers to discover its 
secrets.  As far as laptops go the Picodore is a tiny one.  
It’s a little smaller than those portable DVD players.  It 
includes connections for a disk drive, external keyboard, 
audio/video output, headphones, joystick/userport, 
external power adapter and SD card.  Buttons below the 
LCD screen allow for brightness and volume adjustment.  
There is even a speaker tucked into the enclosure.                
 
CS  
how did you come up with such a great name for the 
machine? 
  
JW 
I wanted the name to emphasize the smallness of it and 
the prefix “pico” means one-trillionth.  Since I already 
own the domain “picobay.com”, it seemed like an easy 
decision.  “Picobay” doesn’t mean anything in particular.  
I registered it way back in 1996.  With the success of 
Ebay, I thought the “–bay” suffix was really going to 
catch on.  Nanotech was just starting to get its roots and 
I figured picotech wasn’t far behind.  I was wrong on both 
counts.   
 
CS 
 Tell the reads a little about yourself 
 
 JW 
My father was in the mining business and a jack of all 
trades.  I learned a lot from watching him patch together 
broken machinery with whatever was on hand.  I, on the 
other hand, was always tearing things apart when I was 
a kid to see how they worked (actually I still do).  I loved 
anything related to computers, electronics and Lego 
blocks.  I wanted a career in robotics and I eventually 
went to school for mechanical engineering.  My last year 
in college, I placed in a national robotic design 
competition and I landed a cool job designing gizmos for 
the U.S. military and space program.  Over the course of 
five years, I moved up in the ranks and, unfortunately, 
became less and less involved in the technical side of 
things.  Consequently, interfacing with the human mind 
and body was another area of interest for me.  So much 
to the bewilderment of my parents (and jealousy of my 
friends), I decided to quit my job and return to school 
again. I'm happy to say that I just received my master’s 
degree in biomedical engineering last month and now I'm 
working on my PhD.  My area of research involves 
implanting electrodes into the brain for both data 
acquisition and stimulation.  It's a dream job for a hacker 
since so much is still unknown about the central nervous 
system and how the various areas communicate with 
each other.  
 
CS 
Please tell us about Commodore and yourself, what 
machines do you own, your first machine, do you still 
use Commodore Machines? 
  
 
 

 
JW 
I'm 29 years old, so I grew up during the middle to end of 
the Commodore's golden era.  I received a C64, which 
was my first computer, when I was about 12.  I loved 
programming and the Commodore was great for that.  I 
was also fascinated with controlling things with a  
 
computer.  I felt like I discovered cold fusion the first time 
I hooked up an LED to the userport and made it blink.  
Needless to say, it wasn't long before I fried the CIA 
chips in that first machine.  A few years later I got a 
C128 but I used it in 64 mode 99% of the time anyway.  I 
lost touch with the Commodore scene during college 
since everything seemed to be PC based in the world of 
engineering.  To tell the truth, I really didn't get back into 
Commodores until a few months ago when I was 
designing a custom video card that relied on control via 
RS-232 input and output composite video.  My initial 
attempt with a microcontroller yielded poor results.  Then 
I thought about my old Commodore and wondered if I 
could use the VIC-II chip and RF modulator.  I bought a 
C64 on Ebay with the intension of gutting it for the 
components that I needed but once I got it in the mail 
and booted it up to that familiar blue on light blue screen, 
I didn't have the heart to destroy it.  During the next week 
I ordered a disk drive and the parts to make a XM1541 
cable.  I learned about the DTV while researching the 
VIC-II.  It was by accident that I saw a DTV-Hummer 
game at a local Radio Shack.  I didn't know what I was 
going to do with it, but I knew they were getting scarce 
so I bought it on a whim.   
 
CS 
Tell us a little more about the project, also how many 
other people would you estimate enjoy DTV and 
Hummer hacking? 
  
JW 
I can’t stress enough how this project is a combination of 
a lot of effort by the entire DTV hacking community.  I 
was just the first person to put it all in a nice little laptop-
ish package.  I, too, would like to know how many DTV 
hackers are out there.  There are about ten very active 
members who are blazing the trial for the rest of us.  I 
really didn’t join the forum discussions until I was almost 
done with my project and I would think there are many 
others reading those message boards and working on 
their own projects.      
 
CS 
I see the machine is battery powered, are these 
recyclable and is the machine able to run from mains 
power ? 
  
JW 
The LCD screen is very power hungry because of the 
type of backlight it uses.  That component basically sets 
the power requirements for the entire unit.  I knew I 
wanted to use rechargeable batteries and thankfully the 
discharge curve of NiMH AA's fit within the voltage 
requirements of the LCD.  The Picodore 64 can also run 
from an AC wall adapter. When the external power plug 
is inserted, the batteries are removed from the circuit via 
a mechanical contact switch in the receptacle.  I wanted 
to make it as useful as possible, but I stopped short of 
actually charging the batteries while they are in the unit. 
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CS 
I have included the specifications of the machine at the 
end of this question and answer session but, please can 
you give us (in as much detail as possible) how you 
came to design the machine and the thought process, 
and problems you had along the way.  
 
JW 
My initial tinkering with the Hummer involved hooking up 
a PS/2 keyboard, disk drive and fixing some problems 
with the video and audio circuits.  It wasn’t until I 
connected the video output to a little LCD screen that I 
decided a tiny laptop was in order.  I read through the 
entire PETSCII forum (THE resource for DTV hacking 
information) to make sure that this would be the first of 
its kind.  I then started looking for a small keyboard with 
the LCD as a guide for the approximate dimensions I 
needed.  I took a chance and ordered a few different 
types.  It turned out that a portable folding keyboard 
meant for a Jornada PDA was the perfect size and had 
all the necessary keys.   
 
The only problem was that it couldn’t be directly 
connected to the DTV board because it didn’t use the 
required PS/2 protocol.  I borrowed an oscilloscope from 
my lab at school and used it to decode the signals.  
Knowing very little about how keyboards work, it took me 
a few days to get a microcontroller to decode the 
Jornada keyboard signals and re-encode them to PS/2.  
Figuring out the power circuit turned out to be easy since 
the various components used standard voltages.  The 
SD card slot interface was adapted from a design by Jan 
Derogee and Pyrofer. 
 
            I started looking for a case to modify as soon as I 
got the keyboard working.  I found a bunch of little 
enclosures that were almost the right size but it would 
have been a lot of work to make it look right.  I ended up 
just making the entire case out of wood and superglue.  
It turned out to be a great decision.  The materials were 
cheap and readily available.  I was able to build the 
entire thing with a minimal set of tools.  All I really 
needed was a saw, drill, sandpaper, dremel tool, 
micrometer and razor-knife.  Covering it with faux 
stainless steel contact paper worked out great and really 
gave the project a professional look.  I don’t think it 
would have received the same amount of attention if I 
left it looking like wood. 
 
            The joystick was one of the last things I did for 
this project.  Realistically I knew the Picodore 64 was 
going to be primarily a machine for playing classic 
games and a full sized joystick wasn’t going to look right.  
I found a miniature Atari keychain joystick that I 
managed to convert into a device that was compatible 
with the Commodore joystick port.    
 
CS 
Would you consider selling the machine if someone was 
interested? 
  
JW 
I've been debating this, but yeah, I probably will 
eventually.  I've got a few other projects that I'd like to 
pursue and as a poor college student my funds are 
limited. 
 
CS 
do you think the machine is a commercially viable 
product for the Commodore community, if it could be 
mass produced? 
  
JW 
This particular design wouldn’t be great for mass 
production since it seemed to take forever to get the 
case done.  But if you’re asking me if a C64 laptop would 
sell?  I would say “Absolutely!”  Granted, a C64 laptop 
doesn't have the market potential of a Sony Playstation 
III, but it definitely fills a niche.   
 

Not only would this be a great creative outlet for all those 
young programmers out there, but the enormous library 
of existing software is a resource just waiting to be 
tapped into.  I think this would be a no-brainer for some 
company out there.  Though, I do have a laundry list of 
things I'd like to see on a mass produced unit.  Some 
sort of memory card slot would be a must to get software 
on and off of it.  A million new C64 laptop owners 
scouring Ebay for 1541 drives and 5.25” floppies isn't 
very realistic.  Also, I'd like to see an enhanced version 
of BASIC and a JiffyDOS-like utility included.  This might 
be upsetting to the Commodore purists out there but my 
own C64 become a lot more entertaining once I plugged 
in a Super Expander 64 cartridge.  I think better access 
to music and graphics from within BASIC could be added 
without sacrificing compatibly.  And let’s face it, if you’re 
that nuts about the C64, you’re probably coding in 
assembly language anyway.   
CS 
 what problems would mass production cause 
  
JW 
The obvious problem involves all the old software that 
was written off as unprofitable and abandoned by 
software companies years ago.  As certain titles become 
popular again, software companies may attempt to 
enforce old copyrights and cause trouble for sharing 
sites.  Hopefully, these companies would choose to 
develop new software instead.  The thought of EA 
Games writing new software for a C64 may sound far 
fetched, but mobile phone gaming has demonstrated 
that there is still money to be made from relatively low 
tech 2D games.  Another problem that is happening right 
now is the legal entanglement of the several parties 
involved in making the current batch of DTV gaming 
devices.  Each party owns a piece of the technology 
puzzle and I’m not sure they are all on the same page 
these days.   
 
CS 
 do you have any other projects in the pipe line? 
  
JW 
Haha, I’m assuming you only want to know about the 
Commodore related projects.  I have another, larger, 
C64 laptop in the works with a 3.5” floppy drive in it.  
Although the Picodore 64 wins the prize for being little, 
it’s really too small for coding without an external 
keyboard attached.  The Commodore 64 has been 
around so long that it’s difficult to come up with an 
original hack for it.  Though I do think my future projects 
will focus on demonstrating that there is still a place for 
this classic machine in today’s world of ultra-fast and 
ultra-complex computer systems. 
 
CS 
I am sure all readers, would like one of these, have you 
had many comments? 
  
JW 
I thought I might get some feedback, but I really didn’t 
anticipate the overwhelming amount of positive 
comments left on various message boards.  And yes, 
many of them do express the desire to own one.  
 
 I would build more of these but DTV Hummer parts are 
getting hard to find.  Besides, my apartment is tiny and I 
need my kitchen table for other things sometimes.  
 
 Finally, I would like to thank all those who have 
contributed to the DTV hacking effort on the PETSCII 
forum.  I also need to thank my girlfriend for not 
complaining during the week that I converted our kitchen 
into a workshop.  She was more than tolerant of the 
layer of sawdust that was deposited on everything in our 
apartment and the frequent trips to the hardware store.   
 
CS 
thanks for your time and efforts  
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Tape Transfer 
 
Introduction 
Almost all of the Commodore 8 bit computers have a 
Datassette connection. The only exceptions I can 
think of are the C64 Games System and it's 
successor the C64 DTV. The Datassette was a 
cheap alternative to the diskdrive and was sold by 
the millions. Most (budget) games for the C64 were 
sold on tape.  
 
So you have a great collection of original tapes or 
made programs yourself on tape and want to use 
them on an emulator. This page will describe how it 
is possible to read the tapes into your modern PC. 
You need to build (or buy) a interface that connects 
an original Datassette to your PC. 
 
Specifications 
This are the specifications I personally use to transfer 
my tape's. Any PC will do that can run MS-DOS and 
has parallel port and a floppy. 
 
PC: Pentium III, 256 MByte, 4 GB HD 
OS: MS-DOS 6.2 + Windows 2000 SP4 
 
Software: 
MTAP + PTAP: Markus Brenner 
http://markus.brenner.de/ 
 
FinalTap: Subchrist 
http://www.coder.pwp.blueyonder.co.uk/ 
 
Hardware: 
C64S interface 
1530 Datassette 
 
Disclaimer: 
Every thing you will do is on your own risk. I have 
made a great effort to get the info on this page right 
but there could be a mistake on this page that I am 
not aware of. If you find an error please let me know 
 
The interface 
First you will have to build yourself a C64S interface. 
It's not very difficult to build. This interface will give 
you a Datassette and a IEC (diskdrive) connection. 

You can see the schematics bellow. 
 
The interface needs a regulated powersupply of  
 
 
exactly 5 volts DC to power the Datassette. There 

are a few ways to connect a power supply, choose 
one of the following. 
It can be done by a external power adapter and a 
voltage regulator as is shown in the top left corner of 
the schematic. The external powersupply can be 
anything from about 9 volts to about 24 volts AC or 
DC. The regulator will make a perfect 5 VDC voltage. 
Another way of getting the 5 VDC is by connecting 
the interface to the gameport of the PC this is shown 
at the top  
 
right corner of the schematic. 
 
The way I did it is to make a connection to the PC 
powersupply directly. I did this because my PC didn't 
have a gameport. You can see the connection 
bellow. After soldering the wire be sure to isolate the 
connection with isolation tape. 
 
In a PC the red wire is the 5 volt DC, but to be sure 
test the voltage. Use a rubber grommit where the 
wire leaves the PC housing to prevent damage to the 
wire. On the photo bellow you can see my first 
version of the C64S interface. 
 
Instead of a connector were you can plug in a IEC 
cable I connected a IEC connector that plugs into the 
diskdrive (top). From a piece of PCB I made a 
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Datassette connector. I made cuts with a junior saw 
in the copper layer. And made the notch in the PCB. 
Use a PCB with only copper on the top side. After 
that I soldered all the wires to the connectors. Put 
some insolation tape on the PCB for the Datassette 
were the wires are soldered. Don't forget the 
connection in the D25 connector between 2 and 15. 
 
If you can't make the interface yourself take a look at 
the website of Markus Brenner. There is a link to 
order a complete interface. 
 
The PC. 
The software that is used for the transfer is written for 
MS-DOS so you won't need a state of the art PC to 
do this. I had an spare Pentium III 600 MHz, a couple 
of 2 GB HD, a CD-ROM and this is perfect for the 
job. I installed Windows 2000 on the second hardisk 
(D:).  
 
So you have access to an emulator like VICE os 
CCS64, zip, internet and much more. But Windows 
2000 can't do MS-DOS. After installing everything I 
installed MS-DOS 6.2 on the first harddisk (C:). After 
doing this the PC will boot to MS-DOS.  
 
Don't panic about the Windows 2000 part. Put in the 
installation CD of Windows 2000 and preform a 
repair of the system. When you now boot the PC it 
will ask which operating system to start (Double 
boot). Don't forget to format your harddisk(s) with 
FAT. If you use NTSF you can't use MS-DOS. 
 
Go to the website of Markus Brenner and download 
MTAP (Read tape's) and PTAP (Write tape's) unzip 
the programs on the MS-DOS part of the harddisk. 
After this you have to get hold of a little program 
called CSDPMI.EXE and put this in the same 
directory as MTAP and PTAP. If you don't have 
CSDPMI.EXE try Google. 
 
Shut down your PC and connect the C64S interface 
and a Dattassette to the interface. Boot the PC to 
MS-DOS and go to the directory with MTAP. Start the 
program MTAP.EXE. The program will list all 
possibilities. If you use the C64S interface connected 
to the LPT1 port the command is very simple: 

 
mtap.exe game.tap [ENTER] 
 
The program will check if the interface is connected 
and ask to PRESS PLAY ON TAPE. If you press play 
on tape the program will record the data from the 

Datassette to a .tap file named game in the same 
directory as MTAP.EXE. With very big tape's such as  
 
compilations you need to increase the buffersize. 
On the photo above you can see the program in 

action. The border of the screen will show lots of 
colors while recording the data. After all the data is 
recorded to the harddisk reboot the PC to Windows. 
And start your emulator and load the game.tap file. 
 
On the photo's above you can see the emulator in 
action. The very cool wallpaper is from  Ingo Ruhnke 
aka Grumbel. http://pingus.seul.org/~grumbel/ 
The program FinalTap from Subchrist   
 

http://www.coder.pwp.blueyonder.co.uk/ 
 
 software can be used to scan the imported .tap file. 
It will identify the speedloader and can export the 
program to a .prg file. Also it can be used to repair a 
.tap file. 
 
If you want to write a .tap file back to a tape you can 
use the PTAP program. 
 
For the users of the 264 series of Commodore 
computers there is a special interface available. 
 
 
Source Taken with permission from 
http://commodoregg.hobby.nl/CommodoreHandleidin
gen/Pagina/INFO-TapeTransfer-GB.htm 
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Interview with Brian Bagnall 
 

Interview Printed with permission from ? 
  
Brian Bagnall may be a name that the Commodore-community will remember: He is the author of a book named "The 

Spectacular Rise and Fall of Commodore", which seems pretty much the thing all "Commodorians" have waited for 
so long: a history of Commodore. 

 
 
 
Question 
1) Brian, this is not the first book on 
computers you wrote. Your last one is about 
"Lego Mindstorms programming". Well, that's 
quite a difference: from a programming book 
to a historic view of a company. Can you tell 
us when (and why) did you get the idea to 
write this book? 
 
Brian 
I first had the idea in 2002, near the end of 
my last book. I started  noticing there was far 
more Commodore nostalgia on the web than 
Apple,  which seemed to conflict with the 
popular perception that Apple was the  big 
dog back then. In the seventies, when the 
personal computer market  kicked off, the 
TRS-80 (and even the Commodore PET) far 
outsold the  Apple II, so Apple did not 
establish the personal computer market as 
Apple  revisionists want you to believe.   
 
The thing that really got me into it  was 
realizing that Commodore sold about 20 
million C64s, yet for some  reason Apple 
receives all the credit even though they only 
sold 5  million Apple IIs. That just didn't make 
sense to me. Why was Commodore being  
ignored? It wasn't until late 2003 that I really 
got into the research  and writing. Once I got 
into it, I knew there was an exciting story. 
 
 
Question 
2) It was essential for you to interview people 
who were involved in  those days - that's why 
the subtitle is "The Inside Story". What can 
the  reader expect as a result of this and how 
close is the result to Michael  
Tomczyk's book (referring to the time he 
covered in his book)? 
 
 
 
Brian 
 
People who have read through the chapters say the 
interviews give a  deeper picture of what was going  
on in the company. 
 
 For me, the interviews  really personalize the story. 
You get to know these people and what  they went 
through to deliver some of these wonderful old 
machines. 
 
 There  were a lot of struggles.With due respect to 
Michael Tomczyk, this book will present a larger 
overview of Commodore than "The Home Computer 
Wars", which I have read.   
His book ends in early 1984 and mostly dealt with 
things at a  managerial level. In my mind, the 

engineering story is at least as important as  the 
marketing and business people. Also, he didn't use 
interviews or  firsthand quotes very much, if at all. It  
 
 
 
was kind of Commodore as seen  by Michael 
Tomczyk. 
 
 
Question 
3) When does the book start, as your homepage lets 
us know that several chapters (that come to the 
readers mind first, like the Commodore typewriters 
and the calculators) were "Bonus Materials" not yet  
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to be read? The book starts with MOS Technology, 
before Commodore purchased them.  MOS 
Technology developed the 6502 microprocessor, 
which revolutionized  
 
the personal computer industry and led to the Atari 
2600 VCS, the Apple  II, the Atari 400 and 800, and 
of course Commodore's computers. The  typewriter 
and calculator chapters are complete but I didn't get 
any real  interviews for those chapters. Maybe after 
the book is out, some of  these people will approach 
me and I can land some interviews before I make  
them available. 
 
 
Question 
4) The people you interviewed are mainly from 
Commodore US, so would  you say that this is more 
or less the story of this part of "Commodore World"? 
 
Brian 
Yes. The story is told mainly from the real corporate 
headquarters’ view of Commodore Business 
Machines. Really there was a thing called 
Commodore International Limited with 
"headquarters" in the Bahamas (a small  rented office 
space with some desks), but that was set up for tax  
purposes. Jack Tramiel worked at Commodore 
Business Machines in the US, and  that was really 
where the action took place as far as engineering the  
machines and making decisions.  
 
Europe, Australia, and Japan are  mentioned a lot 
throughout the book, since they were always central 
to the  survival of Commodore, but the international 
side of Commodore is probably  a whole other story. 
 
You'll read about Bob Gleadow, the GM of 
Commodore UK, Harold Speyer of  Commodore 
Germany, Kit Spencer, the marketing director of 
Commodore UK  who later came to the US, Nigel 
Shepherd of Commodore Australia, and  Tony Tokai 
of Commodore Japan, plus a few Japanese 
engineers. 
 
 
Question 
5) How would you, with having an overview of 
Commodore now, evaluate  the AMIGA-Computer? 
Premature baby, far beyond its time, a waste of 
money  or something else? 
 
Brian 
Waste of money. Just kidding! It was definitely far 
ahead of its time.  I don't think it was a perfect 
computer but it was revolutionary. It  was the first 
truly multimedia personal computer and I don't think 
anyone  would argue with that today. Unfortunately 
Commodore did not know how  to communicate that 
to their potential customers and the machine did not  
survive as the (then) inferior Macintosh did. 
 
 
Question 
6) Tramiel denied to get interviewed on Commodore - 
on the webpage commodorebook.com we can read 
"Jack has a strict no-Commodore interview policy." 
Could you dig out why so? 
 
Brian 
Chuck Peddle, one of the early Commodore 
engineers, says he got burned  by a Baron's article 
that was very harsh on him. I think he cooperated  

with the article and they turned around and 
demolished him. He has given interviews about 
Commodore to German magazines from time to time,  
though, so maybe he just doesn't trust the North 
American media. 
 
He left on bad terms in 1984 and Commodore is 
probably not a happy memory for  
him or Sam Tramiel, his son. Leonard Tramiel seems 
a little more  objective and he sounded frustrated that 
his father would not come out and set  the record 
straight. 
 
 
Question 
7) Co-Editors of your book are well-known 
Commodore experts like Jim Butterfield or Robert 
Bernardo. But had the interviewed people like  
Leonard Tramiel no interest in reading it before it 
gets released? 
 
Brian 
That's an excellent question. I thought long and hard 
about showing the  finished chapters to Commodore 
people but decided against it. There is  personal 
information about them in this book, and not all of it is  
 
flattering. I think it would take away from the 
objectiveness of the story to have those people 
involved in the editing process. 
 
For example, if I showed it to Leonard, he would do 
everything in his power to protect  his father, even 
though Leonard seems like an honest person. I 
would have  this pressure to remove the best parts 
and it would end up dulling the  Commodore story 
rather than enhancing it. 
 
Instead, I decided to pull people who know a lot 
about the Commodore  period. Guys like Martin 
Goldberg from Classic gaming, Gareth Knight from  
the Amiga History Guide, Ian from Commdore.ca, 
and Jim Butterfield (who  was there when a lot of this 
stuff happened).  
 
These guys all have a  love of the Commodore story 
as you can see from their web sites, and they  have 
the knowledge to make sure the story is told 
accurately. 
 
 
Question 
8) Finally, is there a chance that this book will be 
translated into  German language, for example? 
 
Brian 
I think there is a very good chance. I've been 
contacted by at least  three German publishers so far 
and the book isn't even out yet, so I'm  going to try to 
pick the best one (which could be difficult considering 
I  know nothing of the German publishing industry) 
and make a deal for the  translation rights. 
 
 
 
Thanks for the interview! 
 
Brian 
Pleasure. Great questions! 
 
Book available from  
http://www.commodorebook.com/ 
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Artillery Duel
 

 
 
Overview: 
This is an "online" version of Artillery Duel  written to 
demonstrate the potential of multiplayer games over the 
Internet with the Commodore 64.  It's believed to be the very 
first Internet-enabled game for the good old C64!   
 
Features: 
Two players over the Internet or LAN (turn-based)  
Chat (F7) 
Mediocre graphics  
Sound effects  
Joystick control (Port 2)  
Technical Details: 
UDP-based communication (don't forget to forward port 3000 
in your router/firewall)  
Written in DASM assembler  
Uses netlib64, which in turn supports the RR-Net or ETH64 
cartridges.  
 
Download: 
It's Beta 0.004, so contain your expectations. 
The network configuration file follows the proposed standard 
set out by Per Olofsson.  Run the CONFIGURE program to 
choose your network settings.Please note that VICE isn't yet 
supported, as its RR-Net emulation is a bit buggy. 
 
Future Plans: 
Once Artillery Duel is finished, we plan to re-use many of the 
game ideas and protocol into a rewrite of Weather War, 
another C64/PET classic.  From there, a more sophisticated 
platformer/scroller shoot-em-up might be fun.  Eventually, we 
could even implement a server-based MMORPG, possibly 
modeled loosely on the Ultima series of games. 
 
Links: 
Discuss the game's development on the C64  
 
Network Game Development forum. 
http://jledger.proboards19.com/index.cgi?board=c64ngd 
 
Look for opponents on the C64friends IRC chat. 
http://www.c64friends.com/ 
 
Games homepage. 
http://home.ica.net/~leifb/commodore/duel/index.html 
 
Ethernet...on the Commodore 64?  
Introduction 
One of the offbeat things I’m interested in is the possibility of 
connecting a Commodore 64 to an Ethernet  network, and 
ultimately to the Internet.  Why?  Well, because it’s there as 
a fun embedded- systems type project.  There’s lots of 
untapped potential for online network games, and games 
were one of the C64’s strengths.  It also appeals to me in a  
 
Chindogu kind of way – it’s un-useless! ;-) This page is a 
brief summary of the “state of the art” of Ethernet on the C64 
as of November 2006.  It only looks at “true” Ethernet 
solutions – other approaches such as  dialup, PC gateways, 
the Lantronix 10/100/1100 and the Palm Ethernet Cradle are 
covered in the given links. 
 
Hardware Available now: 
There are currently two commercially available Ethernet 
devices for the Commodore 64.  Unfortunately, they aren’t 
standalone – they both need to be combined with another  
 

 

 
 
(usually expensive) cartridge to work.  They also use 
different chips (see associated pages for details), so 
software for one isn’t necessarily usable on the other.  
 
The RR-Net.  Requires one of: Retro Replay, MMC64, 
IDE64 V4 (in development) or Super Snapshot V6 (in 
development) because it plugs into the Amiga-style clock 
port on those cartridges.  Has become the defacto standard, 
as most of the software listed below only works with it.  
Available from Individual Computers, Protovision, Vesalia, 
and C64Reloaded.  
 
The ETH64 – Requires an IDE64.  Available from the IDE64 
team.  
 
In development: 
 
Enhanced TFE – Very promising project with adaptors for 
using it in different configurations (standalone, clock port, 
IDE64 bus).  Updated version of the original TFE cartridge 
prototype.  Next version may be RR-Net compatible.  
Availability unknown.  
 
 Net64 by Till Harbaum – abandoned?  Compatible with the 
original TFE.  Compatibility with RR-Net unknown.  
 
Software 
 
Contiki – Full-blown networking operating system for the 
unexpanded Commodore 64.  Includes web browser, web 
server, telnet client, IRC client, and much more.  Drivers are 
available for any of the hardware listed above.  Uses the uIP 
stack.  Very cool!  
 
GuruTerm – “Telnet” terminal client for calling Commodore-
oriented Telnet BBSes.  Not a full telnet client (Doesn’t 
support  the IAC protocol), but that is in the works.   Uses the 
uIP stack but only works with the RR-Net. 
 
 Singular Browser – Standalone Web browser.  
  
WarpCopy64 – Ultra-fast file and disk image copier that 
works between the C64 and a Windows PC over Ethernet.  
Also RR-Net only.  
  
Libraries / Stacks 
 
uIP – The core of Contiki.  Written in C.  Not tied to any 
particular hardware. 
 
netlib64 – A very lightweight all-ML library.   Written in 
DASM assembler.  Supports RR-Net and ETH64. 
 
ip65 – Written in ca65 assembler. Supports RR-Net only.  
 
VICE Support 
The VICE Emulator can also emulate the original TFE 
prototype or the RR-Net.  Setup instructions are here.  
Interestingly, VICE allows you to have an emulated RR-Net 
essentially connected directly to the C64, a configuration that 
cannot exist yet with real hardware.There is apparently a bug 
with the RR-Net emulation.  On the real hardware, you do 
not “see” the Ethernet-layer packets that you send, whereas 
in VICE you do. 
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Credits 
Leif Bloomquist – Game code 
 
Oliver VieBrooks – Network library code 
 
Thurstan Johnston – Testing 
 

 
 

 
 

 
 

 
 
 
 
 
Raik Picheta – Music 
 
Also thanks to Dustin Chambers, Robin Harbron 
for ideas and assistance 
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Interview with Leif Bloomquist 
By Commodore Free

 
> Please can you introduce yourself 
 
My name's Leif Bloomquist.  I live in Toronto, Canada 
with my wife and13-month old son. 
 
>Please tell us a little about your job and hobbies 
 
I work as a contractor to the Canadian Space 
Agency, developingsoftware and systems for the 
Phoenix Mars Lander project, among otherthings. 
My hobbies are composing music, canoeing and 
camping.  I also playwith old computers sometimes 
too ;-) 
 
>How did you start using Commodore computers 
 
When I was 13 years old, my parents encouraged me 
to the join the computer club at the local library.  We 
had a TRS-80, Coco3 and VIC20 in the club.  The 
VIC20 was my favorite though! 
 
>What is the worst thing in your 
opinion Commodore did 
 
Didn't provide a sensible (or 
affordable) upgrade path from 
the C64/128. 
 
> Why do people still use 
Commodre machines and why 
such a large love for the 
Commodore 64 
 
Nostalgia, and the fact that you 
can tinker with them in ways 
that you can't with a PC.  Plus 
there are a lot of fun games for 
the C64, most of which have 
stood up to the test of time. 
 
>What machines do you own 
currently and out of those 
machines which do you use 
 
I have a modern laptop that I 
use for work and most things.  I 
have a C64 with IDE64 that I use to program with, a 
VIC20 for playing games, and a PET 8296 that my 
wife uses to track what's in our freezer. 
 
 
> your main webpage 
http://home.ica.net/~leifb/commodore/ has some very 
 
useful information on commodore machines what is 
the websites primary idea 
 
Just to showcase various hobby projects I've done, 
hopefully others can learn from them too. 
 
> I like the "The Blue Commodore 64C" and the 
websites detailed information on how to spray your 
own, did you experience and real prolems, any thing 
our reader should watch out for if attempting the 
process himself 
 
Yes, make sure the tape you're using to cover the 
"Commodore 64" logo when painting isn't too sticky. 
 
 

 
> theme here BBS and the internet is this you real 
love for the Commodore machines 
 
I just love the concept of having a C64 hooked to the 
Internet.  It's so silly, and challenging at the same 
time. 
 
> Your presentation from "World of Commodore  
 
2006" goes some detail into the workings of the 
game and how 
 
> TCP/IP protocol works with the game how far is the 
> game to completion 
 
The Artillery Duel game is about 75% done.  I just 
need to add some more graphics (i.e. explosions) 
and make the game more fun by addingwind and 
random playing fields.  Then do lots of testing. 
 

> Do you think More 
Commodore games will 
emerge using multiplayer 
internet access 
 
I hope so! 
 
>Can you take our reader 
though game development 
 
That's a huuuuge topic, but 
basically you follow these 
steps: 
 
1. Come up with the concept. 
 
2. If you're doing something 
that's never been done before, 
do some tests.  Is your idea 
possible? 
 
3. Design your program's 
architecture and requirements.  
How exactly should it work, 
what parts are needed, and 
how should they fit together?  

How will the screen look? 
 
4. Get the basic gameplay working, and try it out.  If 
necessary, go back to step 3 and refine your design. 
 
5. Add graphics and documentation, etc. 
 
6. Do lots of testing. 
 
> You play down the game because of the Grapics I 
see  nothing wrong with them 
 
You're the first one to comment on that ;-)   I'm not a 
graphics designer so the graphics were left simple.  I 
like how they turned out, but they're not as slick as 
some of the newer C64 games. 
 
 
Regards, 
Leif 



Commodore Free 

 - 24 - 

How to Quik menu
How to “Quikmenu” by Commodore Free 

 
Loadstars quick menu system featuring “mini 
presenter” Allows users to quickly and easily create a 
disk based magazine or menu system to launch 
applications and text files. Ok then Creating 
“commodore Free” issue number 4 
 
Layout and art work 
We need a title for the magazine this would be a text 
“title” obviously we are going to use “commodore 
free”, this can be a Doodle, Advanced art studio, Art 
studio, Loadstar SHP format or a Kola Picture,  
If you can draw draw a logo in 2 colours black and 
white and go to the Everyone who can draw 
section. 
 
I am assuming little drawing ability and we are going 
to use a PC to design our Screen. This is a 320 x 200 
screen with the words Commodore Free. The 
conversion will create a mirror image of the screen 
and we need only draw in black and white 2 colour 
design.  Just create a text picture. Right artwork 
created but, this is a PC bitmap we need to convert 
the image to Doodle format and I have used Congo 
for the process.  Start Congo and search for the 
picture, Congo opens a familiar Windows browser to 
look for the files  
 
Now press the convert button (this is the icon of 3 
floppy disks stacked on top of each other) This will 
walk through a Conversion process.  Select the 
output format of “doodle uncompressed” Select a 
location to save the file here just to the root of drive 
c:\ Click NEXT  
 
You can now adjust brightness and Gamma 
correction, the screen will update live so you can see 
the effects. Pressing next moves you to the Dither 
settings I find here you need to go forward and 
backwards through these screens as changing one 
setting will affect others, so it’s a little trial and error I 
selected Everything on Zero except the Gamma 
correction of 2.55 normally works ok .Dither percent 
of Zero and dither kind of nearest click Next select 2 
nearest colours and then click Save the file will be 
saved in our case to the root of our C;\ drive  
 
Getting the File to Disk   
Various utilities exist for getting files to commodore 
disk images just picking one from random then and 
for no reason I am using Copy 64 Start the 
application press F9 to get the menu system  
Scroll through the list and select “create disk image” I 
am going to make a D81 disk So select D81 and 
press enter Give the file a name here I am using 
free4.d81 and the file will be created in the current 
directory.  Select the file and press enter to see the 
images contents Pressing TAB moved between the 
spit screen window display, now look for the Doodle 
image it should end .dd  remember we saved it in the  
 
Root of drive c:\ select the file and press F5 to copy it 
into our disk image, a message will appear about 
renaming or copying now the image has been copied 
to our D81 file  
 
GODOT 
For some reason the file wont load properly in the 
quick menu so we need to run it through Godot, I 
think all Godot does is rename it to ddfree.dd I.e. 
prefix the file with dd otherwise our software cant tell  

 
it’s a Doodle file, anyway it gives an excuse to run 
Godot 
 
Select LOAD as Doodle  and Select SAVE as Doodle  
Then click LOAD on the Right and search for your file 
from disk  Find the file on your disk or disk image  
 
Set the “screen Controls” 
HIRES  
Colours 2 
Exec Area  Clip  
 
Click display to look at the image, ensure its all ok  
Then Click anywhere to return to the menu Screen, 
now we are going to select a region to work on  
 
Image operators Click on Execute and the Clip works 
should already be loaded then select CLIP and draw 
around the area you want then select Accept to 
confirm this as the working area , redisplay then save 
the image with a new name I called mine free2.dd 
save the file uncompressed  
 
Everyone who can draw  
Ok doodle experts and arty types can stop laughing 
now and continue with the tutorial. Ok so we have a 
logo now to convert the logo to the loadstar SHP 
format for further manipulation.  
 
Start Qmenu application and from the list on the right 
select STB PRINT  Run the application, Now select 
the Source disk “where the image file is” and then 
select the Target “where the file will be saved by 
pressing T” 
 
Select the file free2.dd notice Godot added the dd 
prefix  once selected press RETURN to view the file, 
if it looks ok select C to convert the file and then 
select the output format of SHAPE give the file a 
name I am using “SHPfree” now Quit by pressing Q 
to return to Qmenu main screen  
 
Select from the menu SCRNFONT to convert the 
Screen to a font option 1 changes disks so select the 
drive with the file to convert on it then select option 2 
GET SHP Select Make block and drag around the 
image, you may need several attempts but once a 
block is drawn you see the preview if it looks ok then 
you can go on otherwise select make block again 
and continue with the process until you are happy. 
 
Select Make FTS and select 128 characters to 
convert, ours is a big logo, if you select to little fonts 
the screen wont look right as all our letters won’t be 
converted save the file and Exit to main menu.  
 
MR MICK  
Now to the screen layout start MR Mick application  
Select File then  DISK/DIR to select the drive and or 
directory to load the SHP file from  Select the file 
from the list and load the file, remember the image 
will be reversed Black is now white and whit black, 
but as we created a mirror image, you still with me ? 
 
Press F4 to bring back the menu bar, the text will 
look strange cos we have converted it, but don’t 
worry, Press F3 this will show the characters that 
have been used to convert our Screen logo to Text 
characters. Press F5 with is the Colour menu and will 
show the available colours and on the left a 
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representation of the screen border and page colour, 
I am going for Light blue page and black border. 
Select the colour and move to the border or page and 
click to change Press F5 then F3 to return to the 
main menu  SAVE the file, we don’t wnt to be home 
to mr cockup as well as MR Mick Save the file as an 
FTS file  Press F3 then F5 select white for the colour 
of our TEXT logo and then press F5 and F3 now 
colour the Logo, play around reselecting colour or 
whatever you want. 
 
Press Shift and Enter to go to Free text mode should 
be able to type now if it doesn’t work press F5 and F3 
and you can select the Text click on the text and click 
where on the page you want it to appear.  A little 
tidying up and the footer added and we have or title 
screen, basic you can play around more if you like, 
Time is running out and we have lots to look at. the 
items on the footer are optional, and self explanatory, 
the page is already set with hotspots for the mouse 
so all you do is add the text in the rough location. The 
shortcut keys are built in the application  
 
E for exit 
H for Help etc  
 
TEXT Processing  
We need text files, so if you are using some other 
system save the text as plain ASCII standard, and 
then import them to the disk image we created or you 
can enter them free hand if you like typing directly in 
to the editor, the editor loads plain PETAscii files. 
save the files give them names and then copied the 
plain PC text files into my disk image. Now start the 
TEXT to T application from our Qmenu main screen  
 
Selecting the files menu allows you to select the disk 
you use for input, the output files are saved to the 
same disk, ensure you have space on the disk, once 
ou have selected the right disk select DO IT and the 
application looks for the Text files and converts them 
to Commodore format, then renames them with the 
prefix of t. More about why this is later on, once the 
process is done (supercpu users hit turbo) otherwise 
go and make a cup of tea.) Now press SCREW it to 
return to the main menu (Dave this is shocking slang 
language >>Grin<<) 
 
MR EDSTAR 
Now select Mr edstar from the main Qmenu menu 
system this runs the text editor, the editor can load 
plain ASCII (pc text files and convert them on the fly) 
if you want these remember to save them with the t. 
prefix so editor.txt becomes just t.editor the file 
extension isn’t needed! Load the file and click 
through the menus, options exist for centred, 
indented, adding a new line etc. This isn’t a normal 
word processor it may take time to get used to it, 
Once all your files are edited, save them back with 
the same filename, or rename pc text files as 
described above,. 
 
DISK and options 
Nearly there now I suggest you make a copy of the 
Qmenu disk, once done remove all the text files and 
files beginning with B 
 
Basically everything except for  

 
These will be 
needed for our 
disk, the quick.fts 
is our layout 
design screen 
this can be 

deleted and our splendid effort copied in its place, 
Also the quick list is a list of all the files on the disk, 
you can edit it by hand or do the lazy way delete it 
and once the disk is started it will be generated 
automatically with the correct files added, do this at 
the end though after adding all your files! 
 
Now start Mr edstar and load the file quick.ini  
This is the screen options menu, load the file as a c= 
file and not a pc text file You should see these 
options  

 
 
Center 
menu  
Yep 
you 
guesse
d it this 
centers 
our list 
menu 
on 
screen 
other 
options 
are left 
and 
right  
 
 
Backg

round + border 
Sets screen and border colours, although these have 
been already set in MR MICK so are ignored for our 
setup  
 
text 
Text colour  
 
Menu Highlight 
Selects the highlight used for the menu  
 
frame 
Sets the frame colour of the menu  
 
Reader text colour 
Colour of the text when viewing text files  
 
RRF X coordinate + RRF Y coordinate 
Co ordinates for the mini menu layout  
 
Menu Top 
Sets the location of the menu on the screen  
 
reader background 
Colour of the paper when viewing text files  
Play around and get a feel of the options does or 
leave them and see what happens. Save converted 
Text files back to your copy of the disk in the order 
you want them to appear on the menu, Run the disk  
 
Things to note are  
All text files must start with a t. prefix, if you have an 
application this needs to start with a B. prefix, Each 
Application needs a text file otherwise it wont work. 
Then menu system handles displaying text or an 
application with the mini menu, you get the  

 
Read the text files about how you 
can get your applications to run then 
quit back to the menu system  
 
 
Read the documentation! 

QuikMenu Disk 
center menu 
0 background 
0 border 
1 text 
7 menu highlight 
8 frame 
0 reader text color 
00 RRF X coordinate 
16 RRF Y coordinate 
xx not used 
02 Menu Top 
15 reader background 
+++++++++++++++++ 
center menu 
right menu 
# menu (column of left edge of menu) 

2    "!"                      prg 
4    "star"                   prg 
71   "quikmenu.pkd"      prg 
2    "quik.ini"               prg 
17   "quik.fts"               prg 
1    "quiklist"               prg 
4    "hello connect"        prg 
0    "````````````````"        del 

Read It   
Run It    
Forget It
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Interview with Loadstar`s Dave Moorman 
By Commodore Free 

 

Picture used with permission from 
http://www.dickestel.com/expo2005.htm 
photograph taken by Robert Bernardo 

 
>Q. Please intoduce yourself to our Reader 
 
A. My name is Dave Moorman. I am 57 years old, 
and have been a hobbyist  programmer since 1979. I 
am married, have one grown son, and live in  
southeastern Colorado. 
 
>Q. Tell us a little about what you do for a living 
 
A. My real vocation is an ordained clergy with the 
United Methodist  Church. I serve three small 
churches, preaching twice every Sunday  morning. I 
am theologically "progressive," yet revel in the power 
of the Spirit that changes lives. 
 
>Q. For anyone who doesnt know what is your 
commitment to Commodore 
 
A. My first Commodore computer was a C-128, 
bought in 1986 when I needed a real computer for 
my work. Thanks to a flakey power switch and a  
marvelous book (The Complete Commodore Inner 
Space Anthology by Karl J.H. Hildon), I "graduated" 
to the C-64 in 1988. In 1992, I saw a railroading 
game on my sister's PC and had to try to do 
something like it on the C-64.  
 
One of the greatest thrills of my life was getting that 
game -- Sea to Sea -- published on LOADSTAR 
#107. I wrote quite a number of other programs for 
LOADSTAR during the next several years, along with 
some articles. 
 
In 1999, I discovered PC emulation, and suggested 
to Editor Fender Tucker that we make a LOADSTAR 
for PC people. He said "Go for it," and I did. During 
2000, I published eLOADSTAR to a growing number 
of subscribers. At the end of 2000, Fender was ready 
to end the magazine at issue 199 and move on to 
other things, so I offered to continue LOADSTAR as  
long as possible. We just shipped #247, and will 
continue through issue 256. 
 
>Q. What Commodore equiptment do you own 
 
A. I have several C-64s and 1541s around the house 
and church. But my main set-up is a C-64 II, a 1541 
II, and two CMD FD2000 drives. I am ashamed to 
admit that these are not even JiffyDOSed. I do most  

 
of my work on VICE 1.07, since it gives me fast 
access to the harddrive and a couple of great MS-
DOS utilities: 64Copy and 1581Copy. 
 
>Q. Tell our reader a little about the Loadstar history 
>and how you came to be working on the magazine 
 
A. Back in 1982, a couple in Shreveport, LA, decided 
to put together a disk software magazine for the 
Apple II called Softdisk. Jim and Judi Mangham 
began their enterprise on their dining room table, but 
soon grew to office space in downtown Shreveport. 
In 1984, the C-64 was fast becoming the leading 
home computer, and Softdisk, Inc., decided to branch  
 
in that direction. The name LOADSTAR is from the 
command to start the disk  
 
- LOAD"*",8,1. 
 

In 1984, Fender Tucker, a guitarist for a bar band in 
New Mexico, came to Shreveport to become the new 
managing editor of LOADSTAR. Fenderbrought a 
unique "off-kilter" attitude and a quest for something 
he called (but never quite defined as) LOADSTAR 
Quality. 
 
Two things about LOADSTAR impressed me from 
the first issue I every read: First, the magazine -- both 
in text and programs -- was a continuous 
environment. One of the Qualities of a LOADSTAR 
program was that exiting it took the user back to the 
main menu. I thought it must be like being on QLink, 
but I was wrong. LOADSTAR was better! 
 
The other thing -- and this was back in 1988-89 -- 
was that unlike the numerous paper mags, 
LOADSTAR respected the reader's intelligence. 
Many of the paper publications were kind of stuck at 
"here's how you get started." LOADSTAR had 
tutorials on using custom fonts, getting bitmaps to  
work, and compression algorithms. It also had utilities 
and ML toolboxes that openned whole new 
possibilities to programmers. 
 
At some point, Softdisk, Inc., decided to discontinue 
the original Apple II Softdisk publication -- at 
aroundissue 163. In a couple of years, LOADSTAR 
sailed past that milestone and became the longest 
running disk magazine in history.As I said, after 
getting Sea to Sea published, I became a regular 
contributor. During rough times, I imagined moving to 
Shreveport and sitting by Fender and Jeff Jones all 
day long whacking out code. I kind of got my wish, 
except no Fender or Jeff. 
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>Q. Why is loadstar to finish 
 
A. Two factors (maybe three) caused us (my wife is 
the bookkeeper and "stuff it lady") to decide to bring 
LOADSTAR to an end. The first is that our 
subscription base has dwindled. This has always 
been a semi-commercial venture, mostly a source of 
"mad money." Putting together an issue takes a 
certain amount of time -- and waning subscriptions 
no longer covered the time spent. 
 
The second reason is that our supply of new 
programs has dried up. We still get a few -- Ricky 
Derocher, Jane Voskap Jones, John Kaputa, Dennis 
Hildreth, Andrew Roberts, and a few others have 
sent material. But it is harder to find new software. 
Finally, I will probably move in a couple of years. 
Methodist pastors move around a lot. It would be 
best to wind up this section of my life before we are 
sent to Last Chance, Colorado. 

 
>Q. You have started a Secret Society of 
commodorecoders can you explain this 
 
A. Back at the LUCKI Expo -- was it 2004? -- I got 
talking with Bo Zimmerman and others, sharing 
secrets and ideas about coding. I wanted such  
discussions to continue, so I came up with the idea of 
the Secret Society. The idea was to stick to just 
programming on the unenhanced C-64, but both in 
BASIC and ML. About a year ago, I got extremely 
busy with my pastorate and lost touch with the 
SSOCC. I am glad Robin Harbron and Jeff Ledger 
have continued the discussions. I hope to get back to 
it soon. 
 
>Q.Loadstar to me seemed all about getting people 
quality technical information was this the goal 
 
A. I hope we are! I like to offer a range of interactive 
entertainment -- games, puzzles, multi-media, plus 
tools, utilities, and information. 
 
>Q.If someone wanted to start programming where 
would they start 
 
A. With a C-64! And a book on BASIC 2.0. The 
BASIC command list in the user's guide would be a 
start. I would strongly suggest sitting down with the 
book and writing out a program with pen and paper, 
then checking it by hand. The secret to programming 
is learning to think exactly like the machine. 
 
Our NICKEL GAMES CD-ROM includes a good 
beginners tutorial and BASIC bible (which I would like 
to publish in CommodoreFree, if you would be 
agreeable). And LOADSTAR's CompleatProgrammer 

has 2-1581s full of stuff -- from basic BASIC to 
courses on ML. Learning how to use ARRAYS is the 
heart of all programming. 
 
>Q.Do you believe modern systems are too 
complex? 
 
A. Right in One! I realize they must have such 
complexity because of their size. They need the size 
in order to handle huge amounts of data (like wave 
files, photos or movies). And while the internet is 
great, it would not be possible without advertising -- 
which needs photos, etc. So the modern home 
computer is way too big and complex for most users,  
and yet must be so in order to do what most users 
want done. 
 
Back in 1997, I was assigned to a church that had a 
486 PC, and had to spend a lot of time working on it -
- newsletters and such. I also got on the internet on 
the PC. In fact, for a year or so, I barely used my  
C-64. So, even with the SuperCPU, I never got into 
GEOS or Wheels or Wings. I became, instead, a 
"cross-platformer." PC for work. C-64 for fun.Today, I 
use PhotoDeluxe to massage images, then transfer 
them to the C-64 with GoDot. I also do video editing 
and CD and DVD burning on my Pentium 400 Mhz 
machine. And of course, newsletters and databases. 
 
>Q. What's your favourite program/game from 
Loadstar's long history? 
 
A. Recently, I have become addicted to Shamrock -- 
a solitaire by Maurice Jones. Blockhead's Revenge, 
by Kate and Ron Slaminko, keeps me up all night. 
Sea to Sea is still a favorite, as I try to get 6 trains in 
and out of Chicago without a fatal crash.I would say 
that the greatest piece of code ever published on 
LOADSTAR was/is Mr.Mouse, by Lee Novak. It came 
out in 1997, and made the C-64 totally point-and-
click. Plus, it has a marvelous toolbox of useful 
commands such as Print At and Scrolling Menu. 
 
>Q. What's your favourite bit of Commodore 
equipment? 
 
A.The SuperCPU kicks the C-64 into high gear. If 
Maurice Randall ever gets mine fixed, I will be ready 
to go back to my old "brown betty." 
 
>Q. Do you prefer using an emulator or the real 
thing? 
 
A.I use VICE 1.07 -- which works well on my 400 
Mhz PC very well. I like having the whole harddisk at 
my disposal. And, I can flip between 64Copy (where I 
move files to and from disk images), Photo Deluxe, 
GoDot, WinZip, and VICE. I'm spoiled, I guess.For 
me, it is not the machine. It is the platform -- the 
memory map and ML and BASIC, the VIC II and SID. 
I have learned a lot about all this, and still have miles 
to go before I have fully explored this amazing  
computer. 
 
>Q. Will you still be a regular Commodore user once 
Loadstar finishes? 
 
A.I certainly will! Until my mind fails, I will certainly 
get ideas for projects. And the place for me to sit 
down and make them real is the C-64. Here I am god 
(little "g") of 65536 bytes -- who never talk back and  
usually do what I want. And if worse comes to worst, 
I can always press <Alt-R>, and the machine happily 
says READY. 
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THE END 
 


